DPS Smart Book Version 34

**Foreword**

This Defense Personal Property System (DPS) Smart Book is for use by Department of Defense (DOD) Transportation Offices, United States Coast Guard Transportation Offices, and Transportation Service Providers (TSPs). It is specifically targeted to assist Personal Property Processing Offices (PPPO), Personal Property Shipping Offices (PPSO), and TSPs successfully operate in DPS. This Smart Book is effective from 01 July 2016 until superseded.
Table of Contents

What’s New in DPS ................................................................................................... 4
When to Use ETOPS ................................................................................................. 5
DPS “Helpful Hints” for Known Problems ................................................................. 8
DPS Interim Solutions for Known SPRs ................................................................. 10
DPS Joint/Combined Spouse Move Counseling Process ......................................... 12
DPS Points of Contact ........................................................................................... 14
DPS Maintenance Release 2.6.0/3.1.0 .................................................................... 15
SPR 6718: DPS No Longer Presenting State Abbreviation for Destination Rate Area .... 16
SPR 6751: PrePickup Fields Not Populated in Analytics ........................................... 16
SPR 6758: DD Form 1384 Not Populated with Julian Date in Correct Format ............ 17
SPR 6760: GBLOC Displayed Incorrectly in the Consignment Guide ....................... 18
SPR 6777: Invoicing & Approvals Module Queue Sort Capability Issue .................. 19
SPR 6778: TSP Offer Value Modified in Claim with a Status of Settled ....................... 20
SPR 6795: Extra Step in QA Inspections: Clear GBL from Search Filter .................... 21
SPR 7007: PPSO Unable to Rescind a Market Suspension ...................................... 23
SPR 7051: DPS Statistically Valid Subject Area not Populating in Analytics ............ 24
SPR 7257: Results Lost When Navigation in the Tracking Module .......................... 24
SPR 7262/7267: Menu Presents Export and Apply Options Twice ............................ 25
SPR 7270: Tracking/TOPS Shipment Errors not Displaying .................................... 26
SPR 7377: Special Solicitation Rates Accepted in Round 1 Not Transferred to Round 2 27
SPR 7382: Accepted Rates Overwritten in Second Round .................................... 27
SPR 7384: Incomplete Special Solicitation Rates Presented in Rates Analytics after Round 2 27
SPR 7388: Core Errors in the Rates Module ............................................................ 27
SPR 7472: DD 1252 Forms not Available for OCONUS to CONUS Shipments (Hawaii) .. 27
SPR 7482: New Phone Number in Consignment Guide .......................................... 28
SCR 7291: Quick Fixes for the Claims Home Page .................................................. 28
TSCR 7216: Direct Access to Java Removed from Production Baseline ..................... 29
TSCR 7238: Dynamic Code Injection ..................................................................... 29
TSCR 7239: Fortify Results (Remove SSN) ............................................................. 29
TSCR 7241: Fortify Results (Remove Logging Details) ............................................ 29
TSCR 7242: Fortify Results (Encore Input) ............................................................. 29
TSCR 7283: Java 7/8 Upgrade……………………………………………………………………………...29
TSCR 7334: Siebel Open UI………………………………………………………………………………….29
TSCR 7347: Stand Up BPMS webMethods………………………………………………………………39
What’s New in DPS

- **Maintenance Release (MR) 2.6.0/3.1.0** was placed into Production on 01 Apr 16. See page 15 for a list of System Change Requests (SCRs), System Problem Reports (SPRs) and Technical System Change Request (TSCRs) Problem Reports (TPRs) fixes included in the release. Beginning on page 16 is an explanation of each one with screenshots when applicable.

- **Storage in Transit (SIT) Converted to Customer’s Expense and Diversions.** For guidance, please contact the SDDC Operations Support and Quality Team directly or through the SDDC Personal Property Operational Support and Quality Team Organizational box at: usarmy.scott.sddc.mbx.omb-for-pp-ops@mail.mil.

- **DoD Customer Login ID for DPS.** Customers will now have capabilities to create passwords.

- **Auto-Award of Refused Shipments.** DPS will now automatically award any refused or timed out shipments associated with a GBLOC to the next available TSP during peak season. The award process will repeat until the award is accepted by a TSP, the shipment is refused 50 times, or 72 work-day hours have transpired. If the shipment is not accepted, it will be placed in the standard Award queue for processing (i.e., as a normal shipment or a short-fuse offer).

- **Customer Satisfaction Survey (CSS).** To improve the response rate and impact of the CSS in DPS, the email notification sent to DoD Customers now includes a shipment number, and the contents of the survey itself has been modified to focus comments on the performance of Transportation Service Providers (TSP). DoD Customers will continue to receive an email notification to complete a survey on the 7th, 14th and 21st days after delivery of a shipment. The email reminder message no longer contains a link to the survey. Customers are directed to access DPS from the Move.Mil site. Customers select the shipment number (included in the email) in the CSS module, and then click the Survey button. Customers are also advised to contact the SDDC System Response Center (SRC) if they would prefer to have a Telephone Surveyor enter their responses.

- **Self-Counseling Updates.** A number of changes to the Self-Counseling pages were introduced in the 2.3.0 release to help DoD Customers navigate the shipment creation process. On the Home Page, the link to view service specific information is clearly identified as the first step in the process, the Get Started link now includes orders, firearms, motorcycle and POV, and the links to various online brochures are no longer offered. The Useful Links section in the left navigation bar is no longer present, personal contact fields are labeled differently (cell number and personal email preferred for secondary contacts), and in the address Lookup feature, the OCONUS option is now labeled OCONUS (Not Considered a State). On the Additional Information page, the Boat question identifies additional criteria (i.e. over 6 feet 10 inches in width or over 6 feet 5 inches in height). Throughout DPS, any
references to Joint Federal Travel regulations (JFTR) have been replaced with references to Joint Travel Regulations (JTR). Also the link to New Duty Instructions is set in a larger font on the Entitlement Summary page. On the Pickup & Delivery page, the In-Transit section is re-labeled to indicate the contacts are also used for emergency messages.

When to Use ETOPS

1. **Purpose:** To provide guidance on when to use ETOPS to book shipments.

2. **ETOPS Will Be Used for:**
   - Direct Procurement Method (DPM), and Local Move shipments should be entered (counseled) in DPS but processed using ETOPS. Once the customer’s data has been entered into DPS it will be transferred into and processed in ETOPS.
   - All shipments going into NTS should be entered (counseled) in DPS but processed using ETOPS. NTS shipments (NTS/NTSR) to and from the east coast NTS Guardian Moving and Storage, Baltimore MD (AOAH) and Hampton, VA (BOAH) and Metropolitan Van & Storage, Suffolk, Va. (BJAQ) facilities and the west coast NTS facility Metropolitan Van Lines, Benicia, CA (LFAH) should be processed in ETOPS and the shipment documentations mailed or faxed to the NTS facility as outlined in the Personal Property Consignment Instructions Guide (PPCIG). *(ONLY Applies to OCONUS customers)*

3. **ETOPS** is expected to be phased out of service by 2019. For example, NTS capability moves to DPS on a date to be determined.

4. PPSOs will process International One-Time-Only (iOTO) shipments in DPS to and from the following locations.
   - Hawaii (Outer Islands including American Samoa)
   - Guam (Northern Marianas Islands and Federated States of Micronesia)
   - Alaska (OTO locations, i.e. Cordova)
   - Australia (OTO locations)
   - All Boat shipments over 14 feet *(Note 1)*
   - Canada (GBLOC is KKFA)
   - Virgin Islands (GBLOC is OSNC)
- Stavanger, Norway (GBLOC is VIFC)
- Deveselu, Romania (GBLOC is UMNL)
- Bydgoszcz or Szczecin, Poland (GBLOC is WKAS)
- Lask, Poland (GBLOC is WKAS)
- Lille, France (GBLOC is WKAS)
- Papa, Hungary (GBLOC is WKAS)
- Berlin, Germany (GBLOC is WKAS) (Non-Embassy)
- Mexico (GBLOC is HAFC) (Non-Embassy)
- Central and South American countries (Belize, Dominican Republic, Guyana, Nicaragua, Panama, Suriname (GBLOC is HAFC) (Non-Embassy and Non-US Mil Groups) (Note2)
- Cucacao (Netherlands Antilles) (GBLOC is OSNC)
- Singapore (GBLOC is MLNQ) (OCONUS locations only)
- Saudi Arabia (SWAP) HHGs (OCONUS locations only)
- Bahrain (SGNK) (OCONUS locations only)

Note 1: When a boat is moved under the International program, and the customer is also shipping household goods to the same destination, the boat and HHGs will be combined into one shipment and moved as a boat shipment with HHGs. When shipping a boat with a trailer, the overall dimensions of the boat on the trailer as a single unit (Length x Width x Height) must also be provided. This information must be included in the “Additional Remarks” field during counseling.

Note 2: All personnel assigned to the US Mil Groups (Central and South America) are to be processed as Department of State shipments.

PPSOs should continue to process Special Solicitation shipments using ETOPS and not in DPS until further notice. HQ SDDC will publish guidance detailing how the transition to DPS will occur for Special Solicitation shipments. Exception: DPS will only be used for those shipments to and from Singapore, Central and South America and outbound from Thailand.
DPS “Helpful Hints” for Known Problems

The DPS Helpful Hints are provided to facilitate the use of DPS by PPSOs/PPPOs and TSPs until full DPS functionality is achieved.

Excess Costs, Interim Fix

In January 2010 an Interim Excess Costs button was added to the DPS Counseling Module to identify and segregate potential Excess Costs shipments for detailed review IAW individual Service Headquarters guidance. The button causes all DPS shipments, under the identified PCS or TDY orders, to be listed in an Excess Costs queue for individual manual scrutiny by the PPSO and Service Headquarters. All potential Excess Costs shipments may now be entered into DPS. A complete DPS Excess Costs redesign is currently under way between the Service Headquarters, USTRANSCOM J4, SDDC and PMO.

Personally Procured Moves (PPM) 1 Mile Issue

1 Mile PPM Reminder for PPPOs: Be aware while creating or validating a PPM shipment. If the mileage calculates as "1 mile", DO NOT submit the shipment. You should go back to the Pickup and Delivery page and reselect the delivery address at 15 minute intervals. There will be times when DTOD is down so DPS will be unable to retrieve the mileage. If after a few attempts the mileage still calculates as "1 mile" you should contact the DPS Help Desk Tier 1/System Response Center (SRC) and create a Service Request.

Local Move PPM From US24 to Region 15

DPS will not allow a local move PPM from domestic rate area US24 to domestic region 15 (i.e., intrastate. The error received states that “The Channel for the selected pickup and delivery location could not be found. Please contact your local counseling office for further instruction on processing your shipment”

PPM Module “Trigger Questions”

The below listed “rules of thumb” provide the correct responses for both Incentive Based and the two types of

Actual Cost Reimbursement (ACR) PPMs “Trigger Questions”
• For Incentive Based (IB) PPMs:


• For ACR not to exceed GCC:


• For ACR:

The question “Is Government Transportation Available,” must be answered, “No.”

The question, “Is a Commercial Company being used,” can be answered, “Yes or No.” *

* The PPPOs/PPSOs processing an ACR PPM should understand that even though the customer
might be procuring a commercial company to move their PPM that does not necessarily mean that the question is answered “Yes.”

**Enhanced Transportation Operation Personal Property Standard System (ETOPS) Interface**

1. PPSO must click “ETOPS Confirm” under “Route” to complete the transfer of DPM, NTS, NTSR, and Local Move shipments from DPS to ETOPS (shipment status will change from "Send to ETOPS" to "ETOPS Confirm"). Do NOT click the "ETOPS Confirm" button until you have verified that the shipment is on the ETOPS Server. If clicked prematurely it will "flag" the shipment and it will not be sent to ETOPS. At that point the SRC must be contacted and a service request initiated.

2. The file transfer process currently occurs on a 15 minute basis. Depending upon the time of shipment routing it may take up to half an hour to transfer to ETOPS.

3. Counseling and transfer of DPM, NTS, and Local Move shipments in DPS is covered in the Counseling User Guide located under the Training tab in DPS. Counseling NTS shipments are in Section 5, counseling NTS Release shipments are in Section 6, and the transfer process of DPM, NTS, and Local Move shipments to ETOPS are in Appendix B. Details to access ETOPS via DPS with Citrix is in the ETOPS User Guide.

**Emailing DD Form 1814 (Carrier Notice of Suspension) to the TSPs**

When a PPSO initiates a suspension, the TSP should receive an e-mail prompting them to log into DPS to view and/or print the DD form 1814. Many times the DD Form 1814 does not appear in the TSP’s queue and the PPSO is no longer able to retrieve a copy in DPS. This problem has been identified and until it is fixed, any PPSO initiating a suspension should print or save a copy of the DD Form 1814 and forward it to the TSP. DPS sends an email to the TSP providing notification of suspension and instruction the TSP to “login to DPS to view and/or print the DD Form 1814.” Unfortunately, not all suspension actions are visible for the TSP to view. PPSO’s should forward the DD Form 1814 to the TSPs when issuing a Letter of Suspension.

**DPS Interim Solutions for Known SPRs**

These interim solutions are the best available advice to the user until DPS is fully developed. Serena Business Manager (SBM)Tracker numbers are provided as well as the anticipated “fix” date for the DPS modification schedule.
Counseling Section - Interim Solutions

1. **Problem**: Non-Appropriated Fund (NAF) Shipments

   **Details**: NAF shipments must be processed in DPS, however, payment for NAF shipments are currently not handled by Syncada. Therefore, NAF shipments must be manually invoiced to the paying office identified on the customer’s orders (not submitted in DPS).

   **Interim Solution**: The origin PPSO must create a GBL correction notice changing block 21 to the appropriate paying office listed on the orders. The PPSO must provide the TSP a copy of the correction notice and advise them NOT to invoice US Bank via DPS.

   Serena Business Manager (SBM) tracker number: 5675. Planned Fix: TBD

Shipment Management Section - Interim Solutions

1. **Problem**: Excess Costs Computation is Not Correct

   **Details**: Excess Costs computation is not correct.

   **Interim Solution**: Currently DPS calculates Excess Costs for excess weight only based on the estimated weight. Interim Excess solution is to click “Paying Officer Review” if member/employee is potentially in an excess cost status.

   Serena Business Manager (SBM) tracker number 7439. Planned Fix: TBD

2. **Problem**: DPS will **NOT** generate a Certificate of Diversion

   **Interim Solution**: Procedures for the Diversion of a Shipment within the Same Rate Area, OCONUS/CONUS: The Diversion functionality in DPS is not like the legacy program. PPSO who have a diversion are requested to contact the Operational Support and Quality Team @ usarmy.scott.sddc.mbx.omb-for-pp-ops@mail.mil for guidance dance BEFORE taking any actions in DPS. Depending on the situation/location of the shipment, you will be walked through the steps to divert the shipment and reduce movement delays.

3. **Problem**: Code T Airlift of HHGs.

   **Interim Solution**: Code T shipments with Transportation Priority Two (TP-2) are available for use within DPS. Shipment must be to/from hard-lift areas and/or PPSO must have Service Headquarters approval to use TP-2. For PPSOs to utilize Transportation Priority Four (TP-4, space available airlift), they need approval from the assigned aerial ports/ACA in order for these shipments to be processed as Code T in DPS. DPS will transmit advance TCMD data into FACTS as TP-2 and the responsible Air Clearance Authority (ACA) will change to TP-4. The DPS TP-4 transmission to FACTS is an identified problem that will be fixed in a future release.
DPS Joint/Combined Spouse Move Counseling Process
Note: For members completing a PPM, create a PPM application for each member under their orders.

Create shipment application under the Senior Member’s Orders.

Add joint spouse Member’s info under “Additional Information” in DPS.

Identify record as “Paying Officer Review”.

Enter the following Spouse’s information: Joint Spouse, Branch of Service, Grade, First and Last Name, Order #/Date, Appropriation (TAC, SDN, SAC), Est. Wt: Estimate weight for complete shipment.

For multiple shipments, estimate shipment weight to be less than Senior member’s shipping entitlement.

Enter the following Spouse’s Info: Joint Spouse, Branch of Service, Grade, First and Last Name, Order #/Date and Appropriation (TAC, SDN, SAC).

For USAF appropriations: Fund Type: SDN For SDN: Joint SPOUSE for AIN: XXXX For TAC: XXXX For SAC: JOINT SPOUSE.

For all other Services appropriations: Fund Type: TAC For TAC: XXXX For SAC: JOINT SPOUSE.

Enter appropriation details based on Senior Member’s Branch of Service (see examples) NOTE: Enter Joint Spouse, unless both member’s orders have the same fund cite. If so, enter actual fund cite in DPS.

Continue application, as normal.

For USN/USMC

For USAF

For USCg

For USA
DPS Points of Contact

1. Program Executive Office, Household Goods Systems (PEO HHGS)
   709 Ward Drive, Bldg. 1990
   Scott Air Force Base, Illinois 62225

2. SDDC Systems Response Center (SRC)/DPS Help Desk,
   Numbers: (800) 462-2176 Option 5; Email: usarmy.scott.sddc.mbx.g6-src-dps-hd@mail.mil-usarmy.scott.sddc.mbx.g6-src-eta-hd@mail.mil
   Electronic Transportation Acquisition (ETA) Administration

3. User ID and Password Issues Email: usarmy.scott.sddc.mbx.g6-src-eta-hd@mail.mil

4. For additional information on DPS, go to www.move.mil
DPS Maintenance Release 2.6.0/3.1.0

Effective 01 April 2016, DPS incorporated new or improved functionality in several areas. The specific, System Problem Reports (SPRs), System Change Requests (SCRs), and Technical System Change Requests (TSCRs) in this release are listed below.

- SPR 6718: DPS No Longer Presenting State Abbreviation for Destination Rate Area
- SPR 6751: PrePickup Fields Not Populated in Analytics
- SPR 6758: DD Form 1384 Not Populated with Julian Date in Correct Format
- SPR 6760: GBLOC Displayed Incorrectly in the Consignment Guide
- SPR 6777: Invoicing & Approvals Module Queue Sort Capability Issue
- SPR 6778: TSP Offer Value Modified in Claim with a Status of Settled
- SPR 6795: Extra Step in QA Inspections: Clear GBL from Search Filter
- SPR 7007: PPSO Unable to Rescind a Market Suspension
- SPR 7051: DPS Statistically Valid Subject Area Not Populating in Analytics
- SPR 7257: Results Lost When Navigating in the Tracking Module
- SPR 7262/7267: Menu Presents Export and Apply Options Twice
- SPR 7270: Tracking/TOPS Shipment Errors not displaying
- SPR 7377: SS Rates Accepted in Round 1 Not Transferred to Round 2
- SPR 7382: Accepted Rates Overwritten in Second Round
- SPR 7384: Incomplete SS Rates Presented in Rates Analytics after Round 2
- SPR 7388: Core Errors in the Rates Module
- SPR 7472: DD 1252 Forms Not Available for OCONUS to CONUS Shipments (Hawaii)
- SPR 7482: New Phone Number in Consignment Guide
- SCR 7291: Quick Fixes for the Claims Home Page
- TSCR 7216: Direct Access to Java Removed from Production Baseline
- TSCR 7238: Dynamic Code Injection
- TSCR 7239: Fortify Results (Remove SSN)
- TSCR 7241: Fortify Results (Remove Logging Details)
- TSCR 7242: Fortify Results (Encode Input)
- TSCR 7283: Java 7/8 Upgrade
- TSCR 7334: Siebel Open UI
- TSCR 7347: Stand Up BPMS webMethods
**SPR 6718: DPS No Longer Presenting State Abbreviation for Destination Rate Area**

*Primary Users: PPSO Inbound, Outbound and Outbound Supervisor, SDDC DPS Master, TSP Master*

Following the 1.4.07 release, the U.S. State abbreviation was no longer presented after the destination rate area for OCONUS to CONUS shipments.

The system function used to present the state abbreviation was restored for the 2.6.0 release.

**SPR 6751: PrePickup Fields Not Populated in Analytics**

*Primary Users: SDDC DPS Master*

DPS populates Location tables in analytics when the GBL or GBL correction notice are generated. In some cases, the Primary Pickup/Delivery addresses were NOT inserted into the table, and the address field would present with a blank value. In other cases, the Analytics module would populate the incorrect values in the authorized and primary address fields.
SPR 6758: DD Form 1384 Not Populated with Julian Date in Correct Format

*Primary Users: PPSO Outbound Supervisor*

DPS was populating the DD 1384 form with an incorrect value in the RDD Block for shipments with a “J” or “T” Code of Service. For example, DPS would populate Block 13 with a value in a six digit format (e.g., 245600) instead of a Julian Date in the standard three digit format (e.g., 259).

Note the value presented in Block 13 of the form is in the standard three-digit Julian format.
SPR 6760: GBLOC Displayed Incorrectly in the Consignment Guide

*Primary Users: PPSO Outbound Supervisor*

The area of responsibilities (AOR) set was modified to exclude legacy areas, which caused the incorrect display of GBLOCs in the Consignment Guide. Following additional changes to the set, GBLOCs no longer affiliated with a PPSO are no longer presented in the Consignment Guide.

In the example above, the State of Tennessee is selected for the query criteria: the GBLOC AGFM is no longer listed in the query results.
**SPR 6777: Invoicing & Approvals Module Queue Sort Capability Issue**

*Primary Users: SDDC Electronic Billing*

The Invoicing and Approvals module did not retain a selected rows per page value for users. If a user selected 50 rows per page, for example, the system would revert to the default value of ten rows.

The selected value for Rows Per Page will now persist when navigating through pages of results.
SPR 6778: TSP Offer Value Modified in Claim with a Status of Settled

*Primary Users: TSP Master*

The TSP Master is not allowed to modify the value defined for a TSP Offer once a claim is placed in a status of settled (i.e., the value is agreed to by the DoD Customer). The page no longer allows the TSP Master to change the value: it is presented in read-only format after the status changes to “Settled.”

Once the status of claim is settled, the TSP may only enter values in the “Amount paid to DoD Customer” and “TSP Remark” fields. All other fields, including TSP Offer, are presented in read-only format.
SPR 6795: Extra Step in QA Inspections: Clear GBL from Search Filter

*Primary Users: PPSO Quality Assurance*

In the Shipment Management module, a user may access the Origin Inspections page and enter a value to filter the list of available shipments. If a user returned to the Origin Inspections page after submitting an inspection form, DPS maintained the filter value unless it was cleared manually.

Modifications to the application now automatically clear the filter on the Origin Inspections page after a user submits an inspection form.
On return to the Origin Inspections page, the filter value is no longer presented, and the default list of shipments appears.
**SPR 7007: PPSO Unable to Rescind a Market Suspension**

*Primary User: PPSO Quality Assurance*

Personal Property Shipping Office (PPSO) staff were not able to rescind a Market-GBLOC suspension placed on a TSP. Changes to the system allow the PPSO Quality Assurance user to enter a reason and select the Remove Suspension option.

Entry of a Rescindment Reason is required before using the Remove Suspension option.
SPR 7051: DPS Statistically Valid Subject Area Not Populating in Analytics

*Primary Users: SDDC DPS Master*

In the DPS Analytics module, the Subject Area “DPS Statistically Valid” was not populating data as expected. Analysis revealed the job synching the Persprop view with the Siebel base table only updated a subset of records.

SPR 7257: Results Lost When Navigating in the Tracking Module

*Primary User: SDDC DPS Master*

When specific options in the Tracking module are selected (e.g., Invoices, EDI Error Reports, etc.), a number of search fields are presented. A user enters or selects values and submits the values to populate a list of invoices that are presented as a series of pages. If a user selected the navigation option to access another page, DPS would present an error message and no longer present any results. Changes to the code allow for use of the navigation options without encountering errors or loss of search results.
SPR 7262 and 7267: Menu Presents Export and Apply Options Twice

Primary User: SDDC Qualifications, DoD Customer, et. al.

In the SCAC Validation page in the Qualification Forms module, as well as in other areas of the application, a menu of options for various system functions are presented. In these menus, two of the options were presented twice (Apply List and Export). The system has been modified to insure the options only appear once in the menu.

Select an option to apply a list of search terms or select the Export option to save screen content in one of several formats (e.g., HTML, CSV or Text).
SPR 7270: Tracking/TOPS Shipment Errors not displaying

*Primary User: SDDC DPS Master*

In the Tracking module, a number of pages present information in bar graphs. Users can click on the red and green bars to review detailed information. The links for the red bars were not working reliably.

Changes to the code insure DPS will refresh the page and present detailed information when a user clicks a red bar.

Details presented include links to additional views of the data and functional options (e.g., reprocess).
SPR 7377: SS Rates Accepted in Round 1 Not Transferred to Round 2

Primary Users: TSP Master, TSP Rate Filing Representative, SDDC Rates

Special Solicitation Rates for a given Market/Channel/COS accepted in Round 1 were not transferred to Round 2 if they were part of an incomplete set of accepted rates. Changes to the system allow the rates to appear in the Round 2 view.

SPR 7382: Accepted Rates Overwritten in Second Round

Primary Users: TSP Master, TSP Rate Filing Representative, SDDC Rates

In the second round of bidding, DPS was not blocking the submission of rates for a channel with rates accepted in the first round. The new rates were overwriting the accepted rates as well as preventing the transmission of overnight rejection emails associated with the submission of bids in the second round.

SPR 7384: Incomplete SS Rates Presented in Rates Analytics after Round 2

Primary Users: TSP Master, TSP Rate Filing Representative, SDDC Rates

Due to a defect with the rates processor, incomplete sets of Special Solicitation rates were presented following the end of the second round of bidding.

DPS relies on a clean-up script to remove any incomplete sets following the end of the second round. A revised script now prevents the display of incomplete sets of rates.

SPR 7388: Core Errors in the Rates Module

Primary User: TSP Master, TSP Rate Filing Representative, SDDC Rates

When attempting to load the Workbench page in the Rates module, DPS would present core errors if large amounts of data were housed in the database. Changes to the code allow users to access the workbench without encountering core errors due to performance issues with data loads.

SPR 7472: DD 1252 Forms Not Available for OCONUS to CONUS Shipments (Hawaii)

Primary Users: DoD Customer, Counselor, and PPSO Outbound Supervisor

DD 1252 forms were not populating for shipments from OCONUS locations to Hawaii. The web page would populate, but DPS would not allow the user to view or print the form. The system has been modified to allow printing of DD1252 forms for shipments from an OCONUS location to Hawaii.
**SPR 7482: New Phone Number in Consignment Guide**

*Primary Users: PPSO Outbound Supervisor, PPCIG Manager, SDDC Trouble Call*

Added the ability to check if a phone number is new and allow storage of new phone numbers.

**SCR 7291: Quick Fixes for the Claims Home Page**

*Primary User: DoD Customer*

Content and navigation options presented to DoD Customers on the Claims Home page were modified to draw attention to key links and content of interest.

Navigation options on the right side of the page are used to “Start My Loss and Damage Report” or “Start My Claim.”

Options to view Loss/Damage reports and Claims are presented below the associated buttons.

The “Start My” options provide direct access to the pages used to file a report or a claim.

The subordinate pages for reports and claims are still available, and the links to create new reports and forms are still presented on those pages, but users are not required to navigate to the reports or claims pages in order to start the process.

Other changes include a default value of “N” (No) in the “Quick Claims Payment Made” field presented in the claim form and removal of submit and cancel options from the top of the edit claim form (submit and cancel options are still presented at the bottom of the form, however).
TSCR 7216: Direct Access to Java Removed from Production Baseline

*Primary Users: Developers*

To address issues uncovered by Fortify, direct access to Java components via the back door login page in the production baseline version of DPS has been removed. Standard access methods are not impacted.

TSCR 7238: Dynamic Code Injection

*Primary Users: Developers*

Prototype.js upgraded to version 1.7.2 and ESAPI libraries are included in counseling module. Implementation passed static code analysis.

TSCR 7239: Fortify Results (Remove SSN)

*Primary Users: Developers*

The template for automatically generated models was modified to prevent the SSN value from printing to the log.

TSCR 7241: Fortify Results (Remove Logging Details)

*Primary Users: Developers*

Removed logging of unnecessary items: if required, a generic message is logged without revealing system information.

TSCR 7242: Fortify Results (Encode Input)

*Primary Users: Developers*

Input validated and information sent for display is encoded via ESAPI libraries to prevent cross-site scripting attacks.

TSCR 7283: Java 7/8 Upgrade

*Primary Users: Developers*

Web servers were upgraded to the last release version of Java 7 (JDK 1.7 update 80). The application will, however, continue to be compiled at Java version 6. WebLogic Server 10.3.6 (11gR1) is not certified for Java 7 and Kodo is deprecated per Oracle. SOA-based DPS will be Java 7/8 based.

TSCR 7334: Siebel Open UI

*Primary Users: All*

Navigation, style sheet, Siebel templates, and system configuration changes were implemented to create a more consistent design and workflow across DPS modules.
The following images illustrate changes introduced with this release.

**DPS Welcome Page for New DoD Customers**

The Siebel Open UI format rearranges the content of the top navigation bar. Beneath the DPS graphic, File, Edit, View, Navigate, Tools and Help options are offered on every page.

In the **File** menu, users will find the **Log-Off** command used to end a session.

In the **Edit** menu, the **Select All** option may be used to highlight, or select all of the listed entries in a table. When all items are selected, an action option may be used to modify all of the listed records (e.g., to **Close** all of the listed claims).
In the View menu, users may access the Columns Displayed option. Select one or more columns in the pop-up window and use the arrow icons to add or remove columns to create a custom view of the data.

After selecting columns, use the up and down arrows to order the appearance of columns in a table (the first column is left-most, with the following columns presented to the right). Select Save to close the pop-up window and view the data.

Note: the width of the browser will affect how many columns of data are visible. If all of the selected columns are not visible, try opening the browser to the greatest width.

The Navigate menu offers options used to select records listed in a table on a page. The Previous and Next Record options may be used to move through individual records, while the Record Set and First/Last Record options may be used to move through sets of results or to the first or last record in a set.

Navigation options are also offered in the form of arrow icons below each table of records.

The Query options vary depending on the page.

The New Query option will prompt the system to present a default search option for table
content. To conduct a search, enter a value in one or more of the fields and select the Run Query option. If any data matches the criteria, it will appear in the table format.

In modules with a legacy Search function (e.g., Claims), the New Query option serves as a navigation link to the existing capability. For modules that appear in pop-up windows (e.g., Rates), the Query options are not available (i.e., greyed out).

In the Tools menu, the Advanced Sort option may be used to arrange the content of a data table by any of the listed values.

In the pop-up window, select a data element from the drop-down menu for the first Sort By option and select a radio button to indicate if the sort should present results in ascending or descending order.

Select up to three elements to sort by, and then select the OK option to rearrange the content.

The Report option is linked to a Siebel reporting function that is not enabled in this release.

The Help menu offers access to content from Siebel, which covers a wide variety of topics. Select the Contents option to view material in a new browser window.

Topics that address standard icons and the variety of query options are especially useful.
Below the menu links, a revised set of tabs offers access to the various DPS modules (Self-Counseling, Shipment Management, CSS, Claims, etc.). Despite minor changes in appearance, the tabs function in the same manner and the range of options matches user roles just as they have in the past.

If there are more tabs than may fit in a single row on the page, DPS will now present an arrow to the right of the tabs used to access a drop-down menu of additional tab options. Highlight any listed option to access the associated module.

Other cosmetic changes include the shape and color of buttons and the fonts and colors used to present text and links. The Siebel Open UI platform employs a number of stock page (or CSS) templates, and the current presentation of DPS reflects the default standards built into the platform.

In prior releases, the Counseling module presented DoD Customers and Counselors with an option to “Continue” after selecting the affiliated tab in the top navigation bar.

Selection of the Continue option prompted DPS to present the module pages in a separate pop-up window.

For technical reasons, the BVS, Rates, Shipment Management and Tracking modules now use the Continue option and present related content in pop-up windows as well.
Overall, the changes in format, style and color scheme are modest and should be navigable to most users. In the example below, the same page from the Claims module is presented in before/after format, may serve as an example of how the Siebel design templates may change the appearance of an existing page. In the example above, the names of the fields, the pop-up windows and the layout remains the same, but the font and color scheme are different. One key difference is the method used to select an item listed in the Shipments pop-up menu. In the old format, a user selected an icon (>) in the left most column to select the shipment. In the new layout, a user selects the entire row, which is presented with a yellow, shaded background to indicate the item is selected.

In several modules, options were formerly listed in a Show drop-down menu.

In the new template, options that were listed in the Show menu are now presented as links below the row of tabs at the top of each page.
Select any of the links to navigate to the function. Other navigational changes affect how users navigate through sets of listed shipments. On many pages, the first ten shipments were listed, and a user could select an arrow icon to view the next ten shipments, or the previous set of ten shipments. The icons were presented on either side of a numeric label (e.g., 1-10 of 10+) in the upper right corner of a table.

In the new template, users navigate to additional shipments by using arrow icons at the bottom of a table. To move between sets, users select the left or right pointing arrows, or they can select a shipment and use the keyboard controls to scroll down one shipment at a time. The numeric label is still presented, but has no icons on either side. Users may also select options in the navigation menu at the top of the page to select a listed item or move between sets of items.
In another module, the subtle difference in the position of screen elements and controls becomes more apparent. In the TSP Agents/Reps pages, the Add Agents pop-up window reverses the vertical position of the DUNS Number field and the Go option.

Then, after the Go option is selected, a user has to highlight the listed DUNS Number prior to selecting the Pick option. This selection differs from the checkbox found in previous releases. While the highlight method of selecting an option is fairly intuitive, some users may stumble looking for a checkbox or a more explicit method of indicating a selection.
A similar issue occurs in the Pick and Delivery page of the Counseling and Self-Counseling modules. When a user selects the Rolodex icon to select a pickup or delivery address, the screen control used to select or add an address may be presented at the bottom of the page in a pop-up window.
Users must scroll down the page to add or select an address used to complete the form.

The position of the pop-up window varies based on browser type and compatibility settings. Other minor changes may challenge users, but the methods and structure used to shape the application are largely intact, and the standardization of screen elements should provide long term benefits.
TSCR 7347: Stand Up BPMS webMethods

Primary Users: Developers

A new BPMS environment was installed to support a Business Process Management (BPM) approach using components sourced from Software AG. This effort migrated existing Siebel and Java Enterprise Edition (EE) applications to the platform and integrated new resources with existing components in the DPS environment.